
Integrating Sphere Tutorial

This is a general tutorial for users of TracePro and TracePro Expert.



Integrating Sphere Tutorial
Introduction

An integrating sphere is an excellent tool for producing a highly uniform distribution of light. Light rays are introduced into the interior of a
spherical shell, where they repeatedly scatter until they escape through a circular exit port cut through the shell. This tutorial will show you
how to:

• Create the integrating sphere with a circular exit port.

• Create a detector surface outside the exit port.

• Add a surface property to the TracePro property database.

• Assign the new surface property to the integrating sphere.

• Perform a simple raytrace with and without importance sampling.

• View the results on an irradiance map, as well as in tables.

This tutorial assumes that you are familiar with Windows. 
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Integrating Sphere Tutorial
Initializing the Model

Start be opening a new model and applying a model name.

1. From the File menu in TracePro, select New 

2. Select File|Save As, enter demosphere in the File name field

3. Click the Save button. The model window should now be titled demosphere.OML.
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Integrating Sphere Tutorial
Creating two Spheres

You will create the spherical shell by Boolean subtraction using two concentric solid spheres. The exit port will be created by another 
Boolean subtraction using a circular cylinder to cut away part of the spherical shell.

1. From the Insert menu select Primitive Solid to activate the Insert Primitive Solids dialog box. Click the Sphere tab.

2. Change the value in the Radius box to 50. 

3. Click Insert to create the inner sphere. 

4. Press the Zoom All button or select the View|Zoom|All menu to see the new object

5. Change the value in the Radius box to 52 and click Insert again to create the outer sphere.

6. Move the Insert Primitive Solids dialog box out of the way (it can be left open because it is “modeless”).

Outer sphere
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Integrating Sphere Tutorial
Display the System Tree

1. Using the mouse cursor drag the left margin of the model window to the right to expose the system tree. Two objects should be listed,
one for each sphere. Expand the system tree to show all information about the surfaces and materials. The model window should now
appear as follows:

Note: If the system tree does not appear at the left, it is located at the right margin.
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Integrating Sphere Tutorial
Creating the Spherical Shell

The spherical shell is made by subtracting the inner sphere from the outer sphere.

1. Select the Edit|Select|Object mode or press on the Select Object tool.

2. Click the silhouette (outline) of the larger sphere to select it first. Its silhouette will be highlighted. 

3. Click the silhouette (outline) of the smaller sphere to while pressing the Ctrl key to add the smaller sphere to the selection. Both
silhouettes will be highlighted.

4. Select Edit|Boolean|Subtract or click the Subtract button on the toolbar. The Boolean subtract command executes automatically as
soon as the command is selected. The next figure shows the new contents of the model window. If you have made a mistake, click the
undo button located on the toolbar

Note: In the Boolean subtraction operation, the second object selected (the tool) cuts away material from the first object (the blank) 
wherever the two intersect. After this operation, the modified first object is kept, while the second object is deleted automatically. 
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Integrating Sphere Tutorial
Add the Exit Port

The integrating sphere needs an exit port to allow light to leave the object. The exit port will be added by subtracting a cylinder from the
shell.

1. Click the Cylinder/Cone tab in the Insert|Primitive Solids dialog box. Make sure that Cylinder (not cone) is selected, and make
sure that “Elliptical Base” is not selected.

2. Change the Y value of the Base to –45. Change the Major R value of the Base to 8. Change the X value of the Base Rotation to 90.
Change the Length to 10.The Insert Primitive Solids dialog box should now contain the following information: 

3. Click Insert to create the cylinder.

4. Select the spherical shell and add the cylinder with a Shift+Click. Click the Subtract button to perform another Boolean subtraction, it
will cut material from the spherical shell, creating the circular exit port.

Note: When making a selection in the Model Window, Ctrl+Click and Shift+Click are equivalent.
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Integrating Sphere Tutorial
Naming Objects and Surfaces

The system tree can be used to add descriptive names to objects and surfaces.

1. In the system tree there should now be only one object. Rename this object to ”Integrating Sphere“. To rename an object, highlight the
original name (e.g. Object 2) and type in a new name. Note that objects and surfaces being renamed are highlighted in the model
window.

2. Rename the inner and outer surfaces of the integrating sphere in the system tree to “Inner Surface” and “Outer Surface”, respectively.
Rename the cylindrical surface (specified in the system tree as a “Cone”) of the exit port to “Exit Port Surface.” 

3. Click the Save button on the toolbar (or select File|Save) to save the model at this stage.

4. Click the Iso View 1 button on the toolbar to get a better view of the circular exit port. The following figure shows the new contents of the
model window with the system tree expanded.
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Integrating Sphere Tutorial
Creating the Detector Surface

The detector surface will be the top surface of an 8mm diameter thin circular disk located opposite the exit port. To create the detector 
surface:

1. Click the YZ view button on the toolbar to change views back to the original.

2. Click the Cylinder/Cone tab in the Insert|Primitive Solids dialog box. Make sure that Cylinder (not cone) is selected, and make
sure that “Elliptical Base” is not selected.

3. Change the Y value of the Base to –58. Keep the Major R value of the Base equal to 8. Change the Length value to 1.

4. Click Insert to create the disk, and close the Insert|Primitive Solids dialog box.

5. Rename this new object “Circular Disk”. Rename its “Cone” surface to “Outer Edge”, its “Surface 1” (top) to “Detector Surface”, and
its “Surface 2” (bottom) to “Bottom Surface”.

6. Click the Zoom All button on the toolbar to rescale the objects in the model window.
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Integrating Sphere Tutorial
Adding A Surface Property to the Database

TracePro has a Surface Property Editor that can be used to add new surface properties to the database or modify the existing ones. You 
will use this editor to define a new property named “Lambertian” that scatters light diffusely (in a Lambertian distribution) and absorbs 1% of 
the incident light. TracePro enforces conservation of energy, which means that the sum of the absorbed, reflected and transmitted light 
must equal the incident light at a surface. Whenever surface property data are created or modified they are checked for conservation of 
energy. To assist the user, TracePro offers the “Solve for“ command that can be used for automatic calculation of surface properties to 
assure conservation of energy. You will use the “Solve for“ command to correct the Lambertian value for BRDF A. To define the new 
surface property: 

1. Point to From the Define menu, select Edit Property Data|Surface Properties. This will open the Surface Property Editor. Click
Add Property.

2. Enter Lambertian into the Surface Property Name field, select ABg scatter model and click the OK button. This will return you to the
Surface Property Editor dialog box with default numerical values in the fields. 

3. Click the absorptance data field and enter the value 0.01 into the field.

4. From the Solve for drop-down list click BRDF to calculate the correct value for BRDF A (=.346639) and automatically insert it into the
field, as shown below.

5. From the File menu click Save and then Close to save the surface property data to the TRACEPRO.MDB database file and then
return to the model window.

Note: The Lambertian surface property values have only been defined for a single angle of incidence. TracePro will use these values for all 
angles unless additional angles are defined, in which case TracePro will use linear interpolation to obtain data for intermediate angles.

Solve For drop down
BRDF Scatter

BRDF A value

Add Property

Save Property

Scatter Type
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Integrating Sphere Tutorial
Assigning the New Surface Property to the Integrating Sphere

At this point the necessary geometrical objects have been created and 
Lambertian has been added to the surface property database. The 
next step is to assign the Lambertian surface property to the inside of 
the integrating sphere, as follows:

1. Click the Select Surface button on the toolbar.

2. Select the inner surface of the integrating sphere by clicking its
name in the system tree.

3. From the Define menu select Apply Properties.

4. Click the Surface tab.

5. From the Surface Property Name drop-down list select
Lambertian. 

• The figure shows the Apply Properties dialog box at this point.

6. Click the Apply button.

7. Check in the system tree that the Inner Surface of the Integrating
Sphere was assigned the Lambertian surface property.

8. Close the Apply Properties dialog box.

9. Click the Select Surface button on the toolbar to toggle it off.
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Integrating Sphere Tutorial
Setting Raytrace Thresholds

Before tracing any rays you will redefine the flux threshold. The default 
value is 0.05, which means that as rays bounce around and split into more 
rays, the new rays with less than 5% of the starting flux will no longer be 
traced. In order to generate a significant number of rays exiting the 
integrating sphere you should decrease this threshold to 0.0005 

1. From the Analysis menu select Raytrace Options.

2. Click the Thresholds tab and enter a value of 0.0005 for Flux
Threshold as shown.

3. Click Apply and close the Raytrace Options dialog box.
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Integrating Sphere Tutorial
Tracing Rays

In this example you will trace rays from a circular grid. The actual number of 
rays traced will be determined when you specify a Rings value for the grid, 
i.e. the number of rings making up the circular grid of starting points. In this 
case you will use a Rings value of 3, which corresponds to 19 starting rays. 
The rays will start inside the sphere at a 45° angle. 

1. From the Analysis menu select Grid Raytrace, click Grid Setup,
bringing up the Grid Raytrace dialog box.

2. With Annular selected for the Grid Boundary enter 5 for the Outer
radius, and keep the Inner radius equal to 0.

3. With Circular selected for the Grid Pattern enter 3 for the Rings
value.

4. For the Origin change the Z value to 44, leaving the X and Y
components equal to 0.

5. For the Normal Vector change the Y and Z component values to 1 and
-1, respectively, leaving the X component equal to 0.

6. Leave the Up vector X, Y, and Z components equal to 0, 1, and 0,
respectively.

7. The Grid Raytrace dialog box should now appear as follows:

8. Click the Apply & Trace Rays button. This will start an audit of the
model, followed by the specified raytrace. A total of 19 rays will be
traced.

9. When the raytrace has finished, close the Grid Raytrace dialog box.
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Integrating Sphere Tutorial
Raytrace Results

The following figure shows the model window after the Grid Raytrace has finished. Note how the interior of the integrating sphere is filled 
with rays, with a few rays escaping through the exit port.
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Integrating Sphere Tutorial
Setting the Irradiance Map Options

To create an irradiance map to view the flux incident on 
the detector surface, do the following:

1. Select the Detector Surface from the Model
Window or System Tree.

2. From the Analysis menu select Irradiance/
Illuminance Options and make the following
entries in the dialog box.

3. For Map Type select Incident in the Irradiance
drop-down list.

4. For Display select Grayscale on Black from the
Color Map drop-down list.

5. Click the “Automatically calculate Normal and
Up Vectors” box.

6. The Irradiance Options dialog box should match
the dialog shown:

7. Click Apply and move the Irradiance Options
dialog box out of the way.
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Integrating Sphere Tutorial
Viewing the Irradiance Map

An Irradiance Map can be displayed for any surface in the mode by selecting a desired surface and open the plot.

1.  Click the Select Surface button on the toolbar.

2. Click to select the Detector Surface in the system tree.

3. From the Analysis menu select Irradiance/Illuminance Maps to create the irradiance map. It is shown in the following figure.

Rays intercepting the detector surface are visible as white or gray spots in the irradiance map. Although eight rays have intercepted the 
detector surface, only seven are visible in the irradiance map because the eighth has a low flux level.

To view these results in false color:

1. Select Color (rainbow) on Black from the Color Map drop-down list in the Irradiance/Illuminance Options dialog box and click
Apply. 

2. Close the Irradiance/Illuminance Options dialog box.
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Integrating Sphere Tutorial
Viewing the Incident Ray Table

To view a table of the rays striking the detector surface, do the following:

1. From the Window menu select Model:[demosphere.OML] to return to the model window.

2. If the detector surface is not selected (highlighted) in the system tree, select it now by clicking on it in the system tree or the model
window.

3. From the Analysis menu select Incident Ray Table.

4. You can also select from the View menu select Auto Size.

The following figure shows a portion of the table that should be obtained. Note that 9 rays are listed, corresponding to the 9 rays shown in 
the Irradiance/Illuminance Map.
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Integrating Sphere Tutorial
Viewing a individual Incident Rays

From the Incident Ray table, one or more rays can be selected and displayed in the Model Window. 

1. Select Display selected rays from within the Incident Ray Table.
Select one of the rows in the table. Selecting Ray Number 9 will shown a ray with only 10 bounces in the sphere since the Ray Node 
corresponds to the intersection number. 
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Integrating Sphere Tutorial
Viewing a individual Incident Rays (con’t)

The Model Window will be updated to show the selected ray. 

Be sure to Un-select Display selected rays to restore the ray display.
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Integrating Sphere Tutorial
Adding Importance Sampling

“Importance sampling” is a technique in which scattered (and 
diffracted) rays are generated and transmitted towards specific 
“targets” in the optical system that are considered “important.” This 
improves sampling by increasing the number of rays going in a 
direction that is important to you. This technique can be especially 
helpful in stray light analysis where the attenuation of incident light may 
be very great. In this tutorial you will add one importance sampling 
target to the model. Its location, orientation, shape, and size will be 
specified to match the exit port. This will increase the number of rays 
hitting the detector surface, while the flux of each ray will be smaller. 
The same total flux will hit the detector surface as before, but spread 
over many more rays, giving a better picture of the distribution of light 
at the detector surface.

1. Make room on your screen by closing the Irradiance/

Illuminance Map window and the Incident Ray Table window,
as well as any other open dialog boxes.

2. Be sure the Select Surface button on the toolbar is depressed.

3. Select the Inner Surface of the Integrating Sphere.

4. From the Define menu select Apply Properties.

5. Click the Importance Sampling Tab in the Apply Properties
dialog box and click Add.

6. For Target 1 change the Target Center Y value to -49.355851,
change the Normal Vector Y value to 1, and change the Radius
Outer value to 8 as shown. The Up Vector is used for
Rectangular Targets and can be ignored in this case.

7. Click Apply. 

8. Check the system tree to verify that an Importance Target has been defined on the Inner Surface of the Integrating Sphere.

9. Close the Apply Properties dialog box.
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Integrating Sphere Tutorial
Raytrace with an Importance Target

Click the Grid Trace button on the toolbar to start the ray trace calculations. Depending on your computer’s speed, this analysis can take
many minutes or more.

The figure shows the grid raytrace with importance sampling turned on.
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Integrating Sphere Tutorial
Irradiance Map with Importance Sampling

Now you can view the updated irradiance map.

1. Click to select the Detector Surface in the system tree. It will be highlighted in blue.

2. From the Analysis menu select Irradiance/Illuminance Maps. 

3. The following figure shows the resulting irradiance map. Note that many rays have now intercepted the detector surface, and they are
uniformly distributed over the surface.

Note: You can apply smoothing or increase the number of rays to improve the ray sampling in the plot. 
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Integrating Sphere Tutorial
 Arranging Views

Sometimes it is useful to display multiple views simultaneously. For example, with the model, system tree and irradiance map views open 
together, you can select different surfaces on the system tree and automatically see the flux incident on them as well as their highlighted 
location in the model view. You can also include the ray histories view which will also update as you choose different surfaces. To arrange 
these views do the following

1. From the Window menu select Tile Vertical.. You can Resize the different windows to your liking.
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